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 If you prefer the white canvas of previous Snagit versions, changing the default canvas color to white creates 
a similar experience. However, remember that the checkerboard of the transparent canvas does not appear in 
saved images. 

Window Capture Transparency Options 

When the Window input or the Window selector in the All-in-One input is used to capture a window, Snagit can 
capture the transparency of Windows Aero themed title bars. The default behavior places a “clean” white background 
behind title bars.  

 

 This option only affects captures taken with the Window input or Window selector in the All-in-One input. Region 
selections always appear exactly as they do on your screen. 

 

Text Capture 
Text mode provides a solution for anyone copying text from the screen or a dialog box. Text captures include only the 
text on the screen, not graphics. Text capture includes the following features: 

 Capture text from screens that do not allow copy and paste in Windows. 

 Send Output to a variety of destinations. 

 Annotate and time stamp the captured text. 

 Collect captured text in one file to keep a running log of captured passages. Use the text as notes from a Web 
browser or email, or to capture a series of error messages from a program to send to technical support. 

 Customize the text Output using the Output Properties.  

 

For additional capture options, see: 

 Text Longer than a Browser Window 

 Text from a Dialog Box 

 Text in a Scrolling Region Longer Than Window 

 Text from an Object on the Screen 

 Text from a DOS Application 

 Add a Caption Effect to a Text Capture 

 Set Up Folders and File Naming Conventions for Text Capture 
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There are two ways to perform this task.  

1. Click Image tab > Canvas group > Resize tool > Resize Canvas option.  

. 

 All vector-based objects must be flattened in order to resize the entire canvas. If there are vector-based 
objects on the canvas, you are prompted to flatten objects and continue.  

2. The Resize Canvas task page appears. Make selections and click Close. 

 Enter a new width and height. 

 Select image placement. 

 If necessary, change color of canvas when making the canvas larger than the capture.  

-Or- 

1. Grab a handle of the canvas and drag to new size.  

 You do not need to flatten vector-based objects for this method of resizing. However, objects off the canvas 
during the resizing are lost.  

Work with Vector Objects  
Some Snagit Editor tools create vector-based objects. Useful properties of vector objects: 

 Float on the canvas so they can be moved, repositioned, aligned, grouped, and more. 

 Can be resized and their properties changed. For example, their overall height and width, outline width, and 
outline or fill color.  

 Effects such as opacity and shadows can be applied.  

Snagit’s vector-based tools include: Callouts, Arrows, Stamps, Freehand Pen, Highlight, Line, Shapes.  

Create Vector Objects in These Three Ways 

 Paste the contents of the Clipboard on the canvas. 
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Send Attachments in an E-Mail  

1. Highlight one or more captures or media files in the Library. Press <Shift> to select more than one capture or 
media file.  

2. Select Send tab > Outputs groups > E-mail. A new e-mail message appears with the captures or media files 
attached.  

Upload to the Web via FTP 

1. Highlight one or more captures or media files in the Library. Press <Shift> to select more than one capture or 
media file.  

2. Select Send tab > Outputs groups > click FTP. The Send with FTP dialog box appears. Enter the FTP server 
information. Click OK.   

Search in the Library Search Pane 

 You must manage Media files with keywords and flags assigned within Editor or you lose those keywords and 
flags.  
 
For example, to move files with keywords and/or flags from one folder to another, you must use the Folder tab 
within the Search Pane. If you use Windows Explorer or another method to move these files, all keywords and 
flags are permanently lost.  

Search Recent Captures 

The Recent captures category holds four weeks of captures and/or media files you viewed or saved.  

1. Select Search Pane > Recent Captures > Tags tab > Recent Captures category. All recent captures and media 
files will appear in the Library.  

2. To narrow the search, click a sub category. The Library updates with the new search results.  

 

Search Using Keywords 

1. Select Search Pane > Tags tab > Keywords category. (If this category is closed, double-click to open.) 

2. A list of all keywords assigned to captures or media files appears.  

3. Click a keyword to view the captures or media files in the Library.  

 

-Or- 

1. If necessary, review all of the keywords used in the All Keyword list.  

2. Enter keywords for searching in the Keyword Search field. Click the Refresh button  if it is present.  

 Use the Clear button  to clear the search criteria.  

3. The captures or media files that match the search criteria display in categories in the Search Pane.  
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Rename a Saved File 

1. Highlight a saved file in the Library. 

2. Right-click > Rename.  

3. Type a new name.  

Create a New Folder  

1. Select Search Pane > Folder tab.  

2. Browse to a drive or folder.  

3. Press <Ctrl+N> or right-click > New Folder.  

4. The new folder appears. Type a new name.  

Rename a Folder 

1. Select Search Pane > Folder tab.  

2. Browse to a folder. 

3. Right-click > Rename.  

4. Type a new name.  

Delete a Folder 

1. Select Search Pane > Folder tab.  

2. Browse to a folder to delete. 

3. Right-click > Delete. 

Move a Folder  

1. Select Search Pane > Folder tab.  

2. Browse to a folder to cut. 

3. Right-click > Cut. 

4. Browse to a drive or folder. 

5. Right-click > Paste. 

Apply Effects and Modifications to Multiple Files (Batch 
Conversion) 
Apply Snagit image editing filters to multiple captures in batch processing mode.  

Convert one or more graphic image files from one format to another. For example, select six BMP files to convert to 
GIF and store them in another directory for inclusion on Internet Web Pages.  

Open the Batch Conversion Wizard 

To open the Batch Conversion Wizard: 

 In Editor > Snagit button > Convert Images. 

 In Editor > Library view > Right-click thumbnail > Batch Conversion Wizard.  

 In Snagit > Related Tasks > Convert Images. 

 

The Batch Conversion Wizard screen appears. Follow the instructions on each dialog box. 
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Print from the Library 

Quick Print One or More Captures of Media Files 

1. Highlight a capture or media file in the Library. Press <Shift> to select more than one or <Ctrl+A> to select all 
thumbnails. 

2. Press <Ctrl+P> or right-click thumbnail > Print. 

3. The Print dialog box appears. Select a printer if different from default.  

4. Click the Page Setup button to select layout and paper options.  

5. Click Print.  

Print File Names at Bottom of Printed Page 

1. Highlight a capture or media file in the Library. Press <Shift> to select more than one or <Ctrl+A> to select all 
thumbnails. 

2. Press <Ctrl+P> or right-click thumbnail > Print. 

3. The Print dialog box appears. Select a printer if different from default.  

4. Click Page Setup button > Layout tab > Enable Print file names at bottom of page > OK button. 

5. Click Print.  

Print a Contact Sheet of Thumbnail in Library 

Print thumbnails of captures and images in the Library or a selected folder. Select the number of images per column 
and row and include the file name.  

1. Highlight multiple captures or media files in the Library. Press <Shift> to select more than one or <Ctrl+A> to 
select all thumbnails. 

2. Press <Ctrl+P> or right-click thumbnail > Print Multiple Images > Multiple Images Layout button.  

3. The Multiple Images Layout dialog box appears. Set preferences: 

 Number of columns: Number of images to print down the page.  

 Number of rows: Number of images to print across the page.  

 Margins: Margins along the outside of the page.  
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 Spacing: The space or "gutter" between the columns and rows. 

 Automatically fit image: Editor automatically scales the images. 

 Keep aspect ratio: Enable for scaled images to have undistorted height and width 

 Manual fixed scale: Manually set scaling percentages. 

 Default: Change settings to the defaults. The default settings are Top, Bottom, and Left Margins are printer 
dependent. Image location is Upper Left, and Image Scale is set to Fit Image on a Single Page. 

4. Print file names at bottom of page: Print file names beneath each image.  

5. Click OK.  

6. Select a printer if different from default.  

7. Click Print.  

Create an Image Gallery Web Page 

 There are many options for publishing an Image Gallery Web page to the Internet. A good place to look for 
help is the www.HTMLGoodies.com main site. Additionally, here is a link to an informative article entitled 
Where do I put my Website? 

Use the Create a Web Page feature to create an HTML thumbnail sheet that links to full sized images. This is a quick 
way to display digital photographs, screen captures, artwork, and other graphics. 

There are seven different types or themes of Web pages to choose from. Each theme is fully customizable and allows 
you to change the background, font colors, size of the thumbnails, transition effects, and much more.  

The Gallery Web Page creation process uses the Create Web Page Wizard. 

Open the Create Web Page Wizard 

To open the Gallery Web Page Wizard: 

In Editor > Library view > Right-click thumbnail > Create Web Page. 

The Create Web Page Wizard screen appears. Follow the instructions on each dialog box. 

http://www.htmlgoodies.com/nontechintro/ntipart2.html
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Web Page Themes and Options Overview  

The following is an overview of the different themes, a thumbnail preview of the finished page, and a description of 
what features each theme contains. Each of these examples uses the same images, only the theme has changed.  

Theme Preview of Web Page Design and Customizations 

Cool Shades 

 

Design: 

 Vertical scroll. 

 Thumbnail of each image with file name and size.  

 Click a link to view the full size image within a 
separate browser window.  

 Linked page numbering system for accessing the 
next page of images: Example: Go to Page 1, 2, 3.  

Customize: 

 Shaded, color background color for each image. 

 Color or texture background for the main page. 

 Thumbnail size and number per page. 

 Font colors. 

 Link colors. 
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Double Vision 

 

Design: 

 View of two thumbnail images side-by-side in a 
horizontal frame at the top of the page.  

 Click a thumbnail to view the full size image within a 
separate browser window. Use the browser’s Back 
button to return to the gallery page. 

 Previous and Next link system for accessing the 
next or previous page of images: Example: 
Prev|Next.  

Customize: 

 Add a transition that plays when the gallery is 
opened or when moving back to the gallery after an 
image is viewed in a separate browser window. 

 Internet Explorer required for transitions. 

 Background color behind the image display.  

 Color or texture background for the main page. 

 Thumbnail size. 

 Font colors. 

List 

 

Design: 

 Vertical scroll. 

 A thumbnail of each image with file name and size.  

 Click a thumbnail to view the full size image within a 
separate browser window. Use the browser’s Back 
button to return to the gallery page. 

 Previous and Next link system for accessing the 
next or previous page of images: Example: 
Prev|Next.  

Customize: 

 Add a transition that plays when the gallery is 
opened or when moving back to the gallery after an 
image is viewed in a separate browser window. 

 Internet Explorer required for transitions. 

 Thumbnail size and number per page. 

 Color or texture of background for the thumbnail 
table. 

 Color or texture background for the main page 

 Font colors. 

 Link colors. 

Navigator 

 

Design: 

 View of thumbnail images side-by-side in a 
horizontal viewer at the top of the page.  

 Click a thumbnail to view the full size image below 
the viewer.  

 Arrow link system for accessing the next or previous 
page of images: Example: >> or <<.  

Customize: 

 Thumbnail size and number per page.  

 Color or texture of background for the thumbnail 
viewer. 
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 Color or texture background for the main page. 

 Font colors. 

 Link colors. 

Slide Show  

 

Design: 

 Automated slide show of all images in the gallery. 

Customize: 

 Add a transition that plays when the gallery is 
opened or when moving back to the gallery after an 
image is viewed in a separate browser window. 

 Internet Explorer required for transitions. 

 Frame width and height. 

 Duration of pause between each image. 

 Color or texture background for the main page. 

Stripes  

 

Design: 

 View of thumbnail images side-by-side in a 
horizontal frame with or without colored rows.  

 Click a thumbnail to view the full size image within a 
separate browser window. Use the browser’s Back 
button to return to the gallery page. 

 Previous and Next link system for accessing the 
next or previous page of images: Example: 
Prev|Next.  

Customize: 

 Thumbnail size.  

 Number of thumbnails per row. 

 Number of rows. 

 Background color for every other row.  

 Border color around each thumbnail. 

 Add a transition that plays when the gallery is 
opened or when moving back to the gallery after an 
image is viewed in a separate browser window. 

 Internet Explorer required for transitions. 

Thumbnails 

 

 

Design: 

 View of thumbnail images side-by-side in a 
horizontal frame. 

 Click a thumbnail to view the full size image within a 
separate browser window. Use the browser’s Back 
button to return to the gallery page. 

 Previous and Next link system for accessing the 
next or previous page of images: Example: 
Prev|Next.  

Customize: 

 Thumbnail size. 

 Number of thumbnails per row.  

 Number of rows and columns. 

 Border color around each thumbnail. 

 Color of background for the thumbnail frame. 

 Color or texture background for the main page. 

 Font colors. 
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 Link colors. 
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Snagit Technical Reference Guide 
This section contains information pertaining to options found in Snagit dialog boxes and tabs.  

Refer to the following reference information: 

 Capture Modes and Input 

 Capture Modes and Output 

 Image File Format Types and Options 

 Video Capture Output Properties 

 Snagit Command Line Options 

 Snagit Program Preferences 

Capture Modes and Input 

 While there are actually five capture modes, this topic only describes Image, Text, Video, and Web Capture 
modes. For more information on Printer Capture, see Snagit Printer Capture. 

Input Image Capture Text capture Video capture 
Web 

capture 

All-in-One 

   

 

Entire Screen 

   

 

Selected Window 

   

 

Region 

   

 

Fixed Region 

   

 

Object 

  

  

Menu 

 

   

Scrolling Window 

  

  

Scrolling Region 

  

  

Custom Scroll 

  

  

Shape 

 

   

Clipboard 

  

  

Clipboard Chain 

  

  

Graphic File 
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Program File 

 

   

Full-screen DOS 

  

  

Extended Window Capture 

 

   

Scanner or Camera 

 

   

Multiple Areas of the Screen 

 

   

Include the Cursor 

 

 

 

 

Keep Links in Capture 

 

   

Record Audio   

 

 

Fixed Address    

 

Prompt for Address    

 

 

Capture Input Properties 

 Input drop-down menu > Properties. 

Use the Input Properties options to customize a capture.  

First, select the capture Mode and the capture Input. Select Input Properties to change any options. For example, 
enter the dimensions for a fixed region capture or change the scroll direction from horizontal to vertical for an auto 
scroll capture.  

Input Properties  
Available in 

Capture Mode 
Description 

General  Image  Change the background color to use outside the capture area. This is 
useful when capturing irregular shapes. Change the default 
transparency behavior for capturing Windows Aero themed window 
title bars. 

Fixed Region  Image  

Text  

Video  

Change the fixed region size. The fixed region is the rectangle used 
to capture a particular space on the screen. Click the Select button 
and draw a rectangle on the screen the size that you would like to 
use.  

Menu  Image  Capture the menu bar and cascaded menus.  

Scrolling  Image  

Text  

Define Auto Scroll options for Window, Active Window, Region and 
Fixed Region captures.  

The Foreground the Scrolling Window option brings a selected 
scrolling window into view during a capture. 

Try specifying a Scroll Delay if scrolling capture fails. Experiment with 
increasing the Scroll Delay, starting with 300 milliseconds. 

In the Window Auto Scroll options box, set the Scroll Direction: 

 If you select Vertical, also select Scroll from Top of Document. 
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 If you select Horizontal, also select Scroll from Left of Document. 

 If you select Both, scroll is from the Top and Left. 

Scanners & 
Cameras 

Image  Select the scanner or camera source device if you do not want to use 
the system default device.  

TWAIN is a standard software interface that allows applications to 
communicate with a digital imaging device. Snagit allows selection of 
a TWAIN device such as a scanner or camera as the capture source 
for images. This Input option allows users to automatically specify the 
size, shape, direction, shade, and other processing options of images 
as they are transferred from the devices to the PC.  

See also Input Scanners & Cameras Properties. 

Extended Window 

(only available on 
Windows XP and 
Vista) 

Image  Capture windows bigger than the screen. Like Scrolling Window, 
Extended Window Capture captures more than is visible on your 
screen. 

Extended window capture captures the window frame, Auto Scroll 
does not. See also Input Extended Window Properties. 

Links / Hotspots  Image Select the type of links and hotspots to keep. See also Input Links / 
Hotspots. 

Object  Text  Select what items to include in a Text capture. See also Input Object 
Tab.  

Video Capture 
Preferences 

Video  Use the Video Capture Properties options to control Snagit 
application preferences as they relate to video capture.  

For more information see: 

Video Input Capture Preferences Properties 

Video Output File Tab 

Video Capture Frame Rate (Time-Lapse) Setup 

Video Capture Audio Format Setup 

Fixed Address Web  Enter a default URL to use for a Web Capture.  

Web Capture 
Preferences 

Web  See Web Capture Preferences.  

 

Printer Capture 
Preferences 
Options 

Printer  Define where to store temporary printer capture files. Choose to close 
Snagit after the Printer Capture.  

Input General Tab 

 Input drop-down menu > Properties > General tab. 

Options apply to Image capture mode. 

Option Description 

Canvas Color Select the background color to fill in the canvas when taking captures with 
the different shapes. The default canvas color is transparent. 

Clipboard text width (in pixels) For use with Input > Clipboard only. 

Define the width of the capture for a text capture from the Clipboard.  

The default width is 640 pixels. Set width to zero (0) to use the Windows 
desktop width and height for the image dimensions. 

Window capture title bar 
transparency  

Select how Window and All-in-One window selector captures transparent 
Windows Aero theme title bars. For more information, see Transparent 



Snagit 10 Help 

 

Matthew Dyer   • 4 

Background Capture Options. 

Input Fixed Region Tab 

 Input drop-down menu > Properties > General tab 

The Fixed region is the rectangle used to capture a particular space on the screen.  

Options apply to Image, Text, and Video capture modes.  

Option Description  

Width Define the width of the fixed region in pixels.  

Height Define the height of the fixed region in pixels.  

Use fixed starting 
point 

Specify the coordinates of a fixed starting point for the fixed region.  

Starting X Specify the starting x-coordinate for the fixed region.  

Starting Y Specify the starting y-coordinate for the fixed region.  

Select Click the Select button and draw a rectangle on the screen the size that you would like to 
use.  

Input Menu Tab 

 Input drop-down menu > Properties > Menu tab. 

Options apply to Image capture mode.   

Option Description  

Include menu bar Include the menu bar in menu captures.  

Capture cascaded menus Include cascading menus in menu captures.  

Input Scrolling Tab 

 Input drop-down menu > Properties > Scrolling tab. 

Define Auto Scroll options for Window, Active Window, Region and Fixed Region captures.  

Options apply to Image and Text capture mode. 

Option 
Available in this 
Capture Mode 

Description  

Foreground the scrolling 
window 

Image 

Text 

The Foreground the Scrolling Window option brings a 
selected scrolling window into view during a capture. 

Scroll delay Image 

Text 

Try specifying a Scroll Delay if scrolling capture fails. 
Experiment with increasing the Scroll Delay, starting 
with 300 milliseconds.  

Scroll from top of document Image 

Text 

If you select Vertical, also select Scroll from Top of 
Document. 

Scroll from left of document Image If you select Horizontal, also select Scroll from Left of 
Document. 

Scroll direction Image Select the direction for scrolling capture: Vertical, 
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Horizontal, or Both. 

Input Scanners & Cameras Properties Tab 

 Input drop-down menu > Properties > Scrolling tab. 

Select the scanner or camera source device if you do not want to use the system default device.  

Options apply to Image capture mode. 

TWAIN is a standard software interface that allows applications to communicate with a digital imaging device. Snagit 
allows selection of a TWAIN device such as a scanner or camera as the capture source for images. This Input option 
allows users to automatically specify the size, shape, direction, shade, and other processing options of images as 
they are transferred from the devices to the PC.  

Input Extended Window Properties Window or Tab 

 Input drop-down menu > Properties > Extended Window tab. 

Capture windows bigger than the screen. Like Auto Scroll, Extended Window Capture captures more than is visible 
on your screen. Extended window capture captures the window frame, Auto Scroll does not. Resize the window to 
capture a size much larger than the screen. 

If the window you want to capture is not resizable with the mouse, you cannot enter new resize dimensions. For 
example, a maximized window is not resizable. 

Options apply to Image capture mode. Available on Windows XP and Vista only. 

Option Description  

Use default capture size To set a fixed resize amount when resizing windows before capture, place a check 
mark in the Use default capture size box. Leave the box empty if you do not want 
the window to resize. Use this feature if you know exactly how much to resize a 
window to capture the necessary contents. 

Width, Height Enter the Width and Height in pixels.  

You must change Width and Height, either in the default capture size or interactively 
during preview, to get all of the window contents. 

Show extended window 
capture preview  

Open the Capture Preview window before a capture. This can help you set the 
capture dimensions. 

Input Links / Hotspots Tab 

 Input drop-down menu > Properties > Links/Hotspots tab. 

Select the type of links and hotspots to keep.  

Option Description  

Links only Keep only links in the capture. 

All clickable objects Keep links and hotspots for all clickable objects (buttons, checkboxes, radio buttons, 
text fields, etc.) in the capture. 

Input Object Tab 

 Input drop-down menu > Properties > Object tab. 
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Select what items to include in a Text capture. 

Options apply to Text capture mode. 

Option Description  

Object name Include the Windows Object Name in the capture. 

Object description Include the Windows Object Description in the capture. 

Object value Include the object value in the capture. 

Include object property 
names in capture 

Include the object property names in the capture. 

Show tray icon during 
capture 

Include a blinking Snagit icon in the Windows System Tray while recording. 

Capture layered windows Capture moving images from programs with layered windows (for example, the 
animated assistant in Microsoft Word is shown in a layered window.)  

Input Fixed Address Tab 

 Input drop-down menu > Properties > Fixed Address tab. 

Options apply to Web capture mode.   

Option Description  

Web page address Enter or select the Web address for the capture. 

Clear History Clear the entries from the recent Web page address list.  

Once you select this option, you will be prompted to delete all entries. 

 

Capture Modes and Output  
The following table describes the types of output you can select in combination with the various modes.  

Output Image Capture Text Capture Video Capture 
Web 

capture 

No Output 

   

 

Printer 

  

  

Clipboard  

  

  

File 

    

Send by E-mail 

   

 

Snagit Editor 

    

FTP 

   

 

Program 
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Excel 

 

   

Word 

 

   

PowerPoint 

 

   

Screencast.com 

 

   

Multiple Outputs 

   

 

 

See also Printer Capture. 

Capture Output Properties  

 Output drop-down menu > Properties.  

Output Properties options give you even more control over your capture output. Select your capture mode and 
capture Output, then define Output Properties if needed.  

Output Tab 
Available in 

Capture Mode  
Description 

Print Image  

Text  

Printer  

Select the Default Windows Printer or a Specific Printer. You can save 
specific printer properties for future Snagit captures. 

Image File Image  

Printer  

Define how to save captured image files in the different graphic file 
formats.  

Send Mail Image  

Text  

Video  

Printer  

Send the captured file using e-mail.  

Program Image  

Text  

Video  

Printer  

Define preferences for Snagit output sent directly to an external 
program or software application.  

FTP Image  

Text  

Video  

Printer  

Define data for the Output to the Web option.  

If you select Output > FTP, you must configure the properties on the 
Output Properties > FTP tab. 

Text File Text  Save the captured text to an ASCII text file. 

Video File Video  Save the captured video as an AVI file.  

See also Output File, Video Capture Frame Rate (Time-Lapse) Setup, 
and Video Capture Audio Format Setup. 

File Web  Save the Web capture images to files. 
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Output Image File Tab 

 Output drop-down menu > Properties > Image File  

Define preferences for file format, file naming, and location for file storage. 

Options apply to Image and Printer capture mode.  

Option Description 

File format  Select the file format for image captures.  

 Select Remember last used format to use the same type of file format as the 
previous capture. 

 Select Always use this file format to select a file type for every capture. 

Options Access options for the file format chosen.  

Show advanced types Display the entire list of file format options, or just an abbreviated list of the most 
common types.  

Ask for file name Enter a file name after each capture. 

Fixed file name Enter a fixed file name for all of your captures. Use fixed file name if you want to 
continuously and automatically update a capture file.  

Automatic file name Snagit automatically names a series of captures for you. Use if you want to automate the 
capture process to run unattended.  

See Automatic File Name Options. 

Output folder Select an Output Folder for your captures. 

Automatic File Name Options 

 Output drop-down menu > Properties > Image File tab > Automatic file name > Options 

Automatically name your captures, eliminating the need to stop after each capture to name the file and select the 
location to save the file. You can also create a unique file naming scheme and save it with a profile, making capturing 
even more convenient and customized.  

Options apply to Image and Printer capture mode.  

Option Description  

Format Displays the file name components, for example computer name and date. Type in the field or 
select options from the File name components list.  

You can use dashes (-) and spaces to separate the different components.  

Preview Displays you how your file name appears based on your selections. As you add components 
or text to the file name, this field automatically updates.  

Ask before 
overwriting 
existing file 
names 

Prevents Snagit from overwriting existing files. 

File name 
components 

Predefined types of information you can include in your file name.  

Value Displays the value(s) of the component selected.  

Insert Click Insert button to add a component to the Format field.  

Prefix text Enter text that appears at the beginning of the file name. 

Number of digits Enter the number of digits to use for the Automatic Numbering. If you select 3 digits, then once 
the number of files saved reaches 999, the numbering begins over again. If you do not have 
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the Ask before overwriting existing file names enabled, the files are overwritten.  

Starting number Select the first number to use for your saved files. 

Output Send E-Mail Tab 

 Output drop-down menu > Properties > Send Email tab 

Customize Snagit to send captures by e-mail. 

Options apply to Image, Text, and Printer capture mode.  

Option Description  

Prompt each time for 
e-mail settings 

Select to enter new e-mail settings each time you send capture output by e-mail.  

Don’t prompt. Use 
preset e-mail 
defaults 

Preset e-mail settings to send your capture to a specific recipient or address.  

Output Program Tab 

 Output drop-down menu > Properties > Program tab. 

Define preferences for Snagit output when you send directly to an external program or software application.  

Options apply to Image, Text, Video, and Printer capture mode.  

 Option Description 

Select the program to output 
to 

Select the program to send the captures.  

This list is populated from your system registry and contains the applications Snagit 
can use to display your capture. As you add other applications to your system, this 
list automatically updates. 

Add Add an application to the Program output list.  

Edit Edit the parameters for an application currently listed within Program output list. 
See Output Edit Program. 

Remove Delete an application from the list.  

Refresh Search the system registry for applications.  

Ask for file name Select to manually enter a file name and location for each capture.  

Automatic file name Automatically give your capture a file name and location.  

To change the default automatic name, then click the Options button.  

Options See Automatic File Name Options. 

Store files in Select the drive, directory, and folder to store the saved captures before they are 
opened in a program.  

Output Program Tab’s Add Option 

 Output drop-down menu > Properties > Program tab > Add button. 

Manually add another application to the Program output list.  

Option Description 
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Executable to run Select another program’s executable file to add to the Program Output list.  

Display name The application name displays in this field. You can change the name of the application. 

Parameters Command line options for the selected program to run properly. 

You must have the "<CaptureFilename>" parameter since it tells the selected program 
what file to open when the program is executed. 

Example: 

“-min -a -ex “c:\temp\test.zip” “<CaptureFilename>”  

This is an example of the parameters for WinZip. This command adds a new capture to a 
zip file named test.zip. For other parameters, consult the selected program’s 
documentation.  

Output Edit Program Options 

 Output drop-down menu > Properties > Program tab > Edit button. 

Edit applications in the Program output list.  

Option Description 

Executable to run Select another program’s executable file to add to the Program Output list.  

Display name The application name displays in this field. You can change the name of the application. 

Parameters Command line options for the selected program to run properly. 

You must have the "<CaptureFilename>" parameter since it tells the selected program what 
file to open when the program is executed. 

Example: 

“-min -a -ex “c:\temp\test.zip” “<CaptureFilename>”  

This is an example of the parameters for WinZip. This command adds a new capture to a 
zip file named test.zip. For other parameters, consult the selected program’s 
documentation.  

Output FTP Tab 

 Output drop-down menu > Properties > FTP tab. 

Define preferences for Snagit output sent directly to a location on the Web using FTP 

Options apply to Image, Text, and Printer capture mode.  

Option Description  

FTP server Specify the IP Address or DNS Name of the target FTP server. 

Port Specify the port on the server used for FTP services. This is usually port 21, the 
default. 

Remote path Type the directory path on the target server where you want to store captured files. 

Use passive FTP Connect with the FTP server in passive mode. 

Show progress Display the Show Progress dialog box. 

Fixed file name Send a file at regular times to the server that always overwrites an existing file. 

Automatic file name Name files automatically with a sequential number included. Specify the Sequence 
Limit. For example, if you specify a sequence limit of 9, files are written with the 
prefix you specify in the File Name or Prefix box, then a numeral string that writes 
nine files before overwriting the first one. The default is zero (0) for no limit.  
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Use temp/rename 
replacement method 

Send your screen capture to the server with a temporary file name. Then rename 
the temporary file to the name specified in the File Name or Prefix box. 

Server authentication Select if authentication is necessary on the FTP server (it does not allow 
anonymous FTP). Supply the User Name and Password. 

User name Enter the User Name for Server authentication. 

Password Enter the Password for Server authentication. 

Use proxy server Use a firewall or proxy server.  

Proxy server and port If you have selected to use a firewall or proxy server, supply the Proxy Server/Port 
in this field. (A proxy server has a different IP or DNS name, such as 
proxy.companyname.com:8080.) 

Output Text File Tab 

 Output drop-down menu > Properties > Text File tab. 

Customize file name, file format, caption, and location options for Text captures. 

Options apply to Text capture mode.  

Option Description 

TXT - Text File Default option for a text capture. 

Annotate captures Add a caption to the text capture output. 

Caption prefix Enter text that appears before each text caption. 

Append to file Add each text capture to the end of a single file. 

Ask for file name Enter a file name for each capture. 

Fixed file name Assign the same file name to each text capture. Use to continually and 
automatically update the same output file.  

Name Enter the file name if using a Fixed file name. 

Automatic file name Snagit automatically names a series of captures for you. Use if you want to 
automate the capture process to run unattended.  

See Automatic File Name Options. 

Output folder Select a folder for your captures. 

Output File Tab (Web Output) 

 Output drop-down menu > Properties > File tab.  

Customize file name, file format, caption, and location options for Web captures. 

Options apply to Web capture mode.  

Option Description  

Ask for folder name Enter a folder name after each capture. 

Fixed folder name Use the same folder name for each new capture.  

Create a subfolder for each 
capture 

Place each new capture in a subfolder within the designated Output Folder. 

Use a single folder to store 
all images 

Store all of the capture images within the same folder. 



Snagit 10 Help 

 

Matthew Dyer   • 12 

Create a hierarchy of folders 
to store images 

Create folders to match the structure of the Web sites captured. 

Rename files automatically Automatically rename a captured file with the same name. 

Overwrite files Always overwrite a file that already exists in the capture folder. 

Output Print Tab 

 Output drop-down menu > Properties > Print tab.  

Define print preferences for captures. 

Options apply to Image, Text, and Printer capture mode.  

Option Description  

Remember last used 
settings  

Print using the last print options used during a previous capture, in the Preview Window, or 
in Editor.  

This option is not available in Editor. 

Use these settings  Set the default print options. 

This option is not available in Editor. In Editor, select File > Print > Page Setup to override 
the default settings. 

Select printer Select a printer. The default option is Default Windows Printer. 

Properties Change printer properties, such as paper size and orientation.  

Page Setup Only available in Image and Printer capture modes. See Output Page Setup Options for 
more information. 

Output Page Setup Options 

 Output drop-down menu > Properties > Print tab > Page Setup button. 

Use the tabbed Page Setup dialog box to set up how your printed prints on the page. Use the Layout tab options to 
size scrolling captures or large captures over multiple pages.  

Options in this dialog box automatically update in the Printer Properties dialog box options. 

Options apply to Image and Printer capture mode. 

Layout Tab 

Option Description 

Auto Size Scale the image to closely match the size displayed on the screen in Editor. Click on a 
handle and drag the image to position on the page. Or, click on a handle and resize 
the image.  

The actual capture is not resized. 

Fit on page(shrink) Scale the image to fit on one page while preserving the correct aspect ratio of the 
original. 

Fill page (stretch) Scale the image to fit on one page while preserving the correct aspect ratio of the 
original by either stretching or shrinking the image to fill the whole page. 

Fit to width (stretch) Scale the image to fit the width of the page. The length is scaled in proportion and can 
end up being more than one page.  

Manual scale Apply a scaling percentage to the image to decrease or increase its size on the 
printed page. 100% is equal to the image filling up the whole page.  
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Click on a handle and drag the image to position on the page. Or, click on a handle 
and resize the image.  

The actual capture is not resized. 

Fixed size (inches) Define the width and height. The printed capture matches the dimensions, scaling or 
distorting the image if necessary. 

Keep aspect ratio Keep the image aspect ratio fixed when changing the width or height. When setting 
dimensions, the numbers for width and height change interactively to keep aspect. 

Image position Determine the placement of the image on the page.  

Select an Image Position by clicking one of the buttons in the positioning cluster to 
select a location on the printed page. 

Sample image size Use these options to preview your capture.  

This option is not available in the Editor. 

Paper Tab 

Option Description 

Portrait Sets the page orientation to portrait.  

Landscape Sets the page orientation to landscape.  

Margins Set the desired margins. Use the Top, Bottom, Left, and Right options to set the 
desired margins in inches. 

Sample image size Preview how your capture will look.  

This option is not available in the Editor. 

Image File Format Types and Options 
Snagit provides 28 different file formats to use for Image and Printer captures . 

Alpha transparency is only available in the PNG and SNAG file formats. 

Select the Show advanced types checkbox to view all 28 file or uncheck to view an abbreviated list of the most 
common types.  

Select the file format for image captures.  

 Select Remember last used format to use the same type of file format as the previous capture. 

 Select Always use this file format to select a file type for every capture. 

What File Format Should I Choose? 

 Click the option in the Available Options column to see the description. 

File Types Available Options 

BMP - OS/2 Bitmap Colors 

SubfileType 

BMP - Windows Bitmap Colors 

SubfileType 

CAL - CALS Colors 

SubfileType 

CMP - LEAD Colors 

Quality 
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SubfileType 

CUR - Windows cursor Colors 

Append if file exists 

Transparency On 

EMF - Windows Enhanced Metafile Format Colors 

 

EPS - Encapsulated 
Postscript 

Colors 

 

GIF - CompuServe GIF 

GIF format is limited to 256 colors and is a lossless compression file format, a 
common choice for use on the Web. GIF is a good choice for storing line 
drawings, text, and iconic graphics at a small file size. 

Colors 

SubfileType 

Transparency On 

ICA - IBM IOCA [Wrapped] Colors 

SubfileType 

ICO - Windows Icon Colors 

Append if file exists 

Transparency On 

IMG - GEM Image Colors 

JPG - JPEG image 

JPG format is a lossy compressed file format. This makes it useful for storing 
photographs at a smaller size than a BMP. JPG is a common choice for use 
on the Web because it is compressed.  For storing line drawings, text, and 
iconic graphics at a smaller file size, GIF or PNG are better choices because 
they are lossless.  

Colors 

Quality 

SubfileType 

MHT - Web Page with Image 

MHTML is similar to an HTML Web page, except that the HTML and images 
are combined into a single file. MHT is useful for quickly sharing an image 
along with simple links/hotspots with just one file and is most useful in e-mail, 
where the Web page, complete with images, is inserted directly into the body 
of the e-mail in Outlook and Outlook Express. 

No options available. 

MSP - Microsoft Paint  Colors 

PCT - Macintosh Picture Colors 

PCX - PC Paintbrush Colors 

PDF - Adobe PDF PDF Page Setup 

PNG- Portable Network Graphics 

PNG format is a lossless compression file format, which makes it a common 
choice for use on the Web. PNG is a good choice for storing line drawings, 
text, and iconic graphics at a small file size. 

It also supports transparency. 

Colors 

PSD - Adobe PhotoShop 3.0 Colors 

RAS - SUN Raster Colors 

RAW - IBM IOCA[Raw] Colors 

SubfileType 

SNAG - Snagit Capture File 

SNAG file format is an Editor-only format that retains vector-based objects. 
If captures or image files containing vector objects are saved as a format 
other than a .SNAG file, the vector objects will be flattened and made a 

No options available. 
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permanent part of the image. Once flattened, the vector objects cannot be 
separated from the image. 

SWF - Macromedia Flash 

To use the hotspots with Flash Popup properties, you must use the E-mail 
Output or save as a Macromedia Flash file (SWF). Flash is used for 
interactive images intended for Web sites or for viewing within a browser.  

No options available. 

TGA - Truevision Targa Colors 

TIF - Tagged Image File Colors 

SubfileType 

WFX - WinFax Colors 

SubfileType 

WMF - Windows Metafile Format Colors 

WPG - WordPerfect Colors 

File Format Option Descriptions 
Depending on the file format chosen, various options are available. See Image File Format Types and Options to 
find out which options are available for each file format. 

Colors  

Select the number of colors (color depth) to save in the image. The number of colors available depends on the 
selected file format.  

 Transparency requires 32 bit color depth as well as a file type that supports alpha transparency. 

Quality 

JPG compression always loses some image quality. Quality specifies the quality of the compressed image, where 100 
is the highest and 1 is the lowest. The higher the image quality adjustment, the longer it takes to convert and save the 
file. 

Subfile Type  

Select from available subfile types. Depending on the current Colors selection, various Subfile Types are available. 

Progressive JPG files are the same as regular JPG files, but the image displays at full size as quickly as possible, and 
clarifies as it is loaded.  

TIFF is a tag-based file format designed to promote universal interchanges of digital image data. There are many 
versions of TIFF. Snagit supports the standard TIFF formats. 

Append if file exists 

Add the new icon image to an existing Windows icon. 

Transparency On 

Use to set a single color in a GIF file or enable alpha transparency in a PNG or SNAG file. For more information, see 
Transparency. 

Title, Author, and Keywords 

Enter the title and author to display in the Document Properties Description tab in the PDF reader.  
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Add keywords for an Adobe PDF document. Keywords are used in Description of the document and in document 
metadata. See Adobe Help documentation for more information on how to use keywords. 

PDF Page Setup 

Open the PDF Page Setup dialog box to preview and adjust page setup options, such as page size, margins, page 
orientation, and image layout.  

Custom Color Depth 

 Editor > Image tab > Modify group > Color Effects > Color Depth. 

Customize the color resolution, dithering and palette of an image after capture.  

Use a unique, Optimized palette to get the best possible image quality.  

To verify a bitmap has a unique palette, open an image from a 8 bits per pixel (256 colors) or fewer file. By default, 
Snagit loads the palette stored in the file and relates it to the bitmap in memory. Or, let Snagit make an optimized 
palette for the image by decreasing a 24-bit image (16 million colors) to 8 bits per pixel (256 colors). Images with 
optimized palettes may exhibit some palette shift. 

Option Description 

Colors The options available range from Monochrome (1-bit) to True Color (32-bit). 

Color Order Specify the Color Order: Red-Green-Blue or Blue-Green-Red.  

Option only available with 16-bit or higher color, and only from Editor. 

Dither Method 

(Option only available if Colors is 
set to 256 or fewer colors.) 

Use the Dither Method list box options to make the image look smoother 
when an image’s color resolution is decreased.  

Select from the following options: None, Floyd Steinberg, Stucki, Burkes, 
Sierra, Stevenson Arch, Jarvis, Ordered, and Clustered. 

Palette 

(Option only available if Colors is 
set to 256 or fewer colors.) 

Fixed 
Save the image using a fixed palette. A fixed palette prevents a decrease in 
the quality of image appearance when more than one image is open. 

Optimized (Recommended)  
Save the image using a palette optimized for this image.  

Identity 
Save the image using the Windows system palette. Use this selection if the 
image contains Windows screen colors. 

PDF Page Setup Options 

 Output drop-down menu > Properties > Image File tab > PDF file output > Options button > File Format   
       Options dialog box > PDF Page Setup button. 

Define how your PDF appears on the page.  

Option Description 

Page size Select the size of page for the PDF. Use the dropdown menu to select a preset size or 
select Custom and manually enter the height and width of the page in inches. 

Margins Select the size of the margins for the PDF in inches. 

Orientation Define the page orientation to portrait or landscape. 

Image Layout Define the capture to shrink to fit on one page or allow the capture to stay its original size 
and span multiple pages. 

Preview Preview the PDF page setup.  



Snagit 10 Help 

 

Matthew Dyer   • 17 

Video Capture Output Properties 
Use the Video Capture Properties options to control Snagit application preferences as they relate to video capture.  

For more information see: 

 Video Input Capture Preferences Properties 

 Video Output File Tab 

 Video Capture Frame Rate (Time-Lapse) Setup 

 Video Capture Audio Format Setup 

Video Input Capture Preferences Properties 

 Input drop-down menu > Properties > Video Capture Preferences tab. 

Define Snagit video capture options 

Option Description 

Temporary capture file directory Select the directory to put temporary video.  

The AVI video capture file can be large. Select a TEMP directory on a drive 
with fast data transfer and plenty of space.  

Pause before starting capture Open a status screen before video capturing starts. The pause allows you to 
see video settings before you start recording.  

Boost priority during capture Select to give Snagit video recording higher priority to your computer CPU. 
We recommend you select this option unless the performance of the program 
is affected. 

Hide capture rectangle Turn off the video capture focus rectangle during captures. 

Use fast internal compression 
during capture 

Automatically use fast real-time compression during video capture. 

Depending on the codec compression speed, AVI rendering times may be 
long after capture. 

Show tray icon during capture Display a blinking Snagit icon in the Windows System Tray while recording. 

Capture layered windows Capture moving images from programs with layered windows (for example, 
the animated assistant in Microsoft Word is shown in a layered window.)  

Layered window capture applies to Microsoft Windows 2000 and XP or later. 

Default Reset the default Video Capture Preferences.  

Video Output File Tab 

 Output drop-down menu > Properties > Video File tab 

Customize the configuration of your video capture output.  

Option Description 

Auto configure Snagit automatically configures video options such as frame rate and compression 
quality. Disable to configure the Video Options manually. 

Frames per sec Enter the frame rate for video capture. 

Video Setup Select a video compression codec, adjust compression quality, and specify key frame 
and data rates in the Video Setup dialog box.  

Time-lapse capture Capture a time-lapse video capture. 

Time-Lapse Setup Configure the AVI Capture and Playback rates in the Frame Rate Setup dialog box.  
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Audio Setup Configure the name, format, and attributes of the audio output in the Audio Format dialog 
box.  

Audio capture device Select the audio capture device that you will be using for Video Capture.  

Ask for file name Enter a file name before saving the capture output. 

Fixed file name Assign the same file name to each capture. This is useful for continually and 
automatically updating the same output file.  

Name Enter the file name for the Fixed File Name option. 

Automatic file name Automatically assign your capture a file name and location.  

You can move directly into the other application with your capture rather than going 
through the manual naming process via the Save As dialog box.  

Click the Options button to change the default auto name.  

Output folder Select an Output Folder for your captures. 

Video Capture Frame Rate (Time-Lapse) Setup 

 Output drop-down menu > Properties > Video File tab > Time Lapse Setup button. 

Option Description 

AVI Capture Rate Define the number of frames to capture and specify a time scale. 

AVI Playback Rate Define the video playback rate. 

Default Restore the default frame rate configuration. 

Video Capture Audio Format Setup 

 Output drop-down menu > Properties > Video File tab > Audio Setup button. 

Option Description 

Name Assign a meaningful name to the Audio Formats.  

For example, select Telephone Quality includes 11.025kHz, 8 Bit, Mono attributes. 

Save As Save an audio recording profile. 

Remove Remove an audio recording profile from the dropdown list.  

Format Select the audio format for a new recording profile. Currently the only option is PCM (Pulse 
Coded Modulation), which is an uncompressed audio data format. 

Attributes For most of the attributes, the higher the number, the higher the quality of the recording and 
the larger the movie file. 

 

The attributes include (from left to right): 

Sample Rate in kHz 
Number of audio samples per second, or the fidelity of the audio recording. 

Sample Size in Bits 
How much data to record for each audio sample. 

An 8-bit sample size is possibly satisfactory for voice recording. Since using a 16-bit sample 
size doubles the size of the audio data you record, use it only if you must have the highest 
quality recording. 

Mono or Stereo 
The number of audio channels to record. Mono means record one audio channel, Stereo 
means record two audio channels (right and left). 



Snagit 10 Help 

 

Matthew Dyer   • 19 

Stereo audio format doubles the size of the audio data you record, only use Stereo only if you 
record with a stereo microphone. 

Data Rate 
The data throughput of the audio stream in kilobytes per second (kbps). 

Snagit Command Line Options 

Snagit Program Command Line Options 

Option Description 

/h Hides the Snagit window at startup. 

/n Disables keyboard input to Snagit (For use with DDE programs.) 

/i Starts Snagit as a minimized icon. 

/S Causes Snagit to do a capture using current settings and close when finished or canceled. This 
option runs Snagit hidden with hotkeys disabled. 

/SC Causes Snagit to do a capture using current settings and continue to operate after the capture 
(not close). This option runs Snagit hidden with hotkeys disabled. 

/OC  Opens the Catalog Browser directly. 

/OE  Opens the Editor directly. 

<filename>  Opens the image file specified directly in Editor.  

/t Starts Snagit with the system tray icon disabled. 

Install Program Command Line Options 

Option Description 

/S Performs the installation silently - no prompting the user.  

See the readme.txt file included in the installation directory.  

Snagit Program Preferences 

 Snagit > Tools menu > Program Preferences.  

Set up and change preferences for general Snagit hotkeys, program options, notifications, and update options.  

For more information see: 

 Snagit Hotkeys Tab 

 Snagit Program Options Tab 

 Snagit Notifications Tab 

 Snagit Update Options Tab 

Snagit Hotkeys Tab 

 Snagit > Tools menu > Program Preferences > Hotkeys tab. 

Use the Hotkeys tab options to set and change general Snagit hotkeys.  

Option Description  

Global Capture Select the keys you push to start a capture.  
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hotkey Select a combination of boxes for <CTRL>, <SHIFT>, and/or <ALT>, and a keyboard 
character. The global capture hotkey captures using the profile selected in the Snagit main 
interface. 

Hide/Unhide 
hotkey 

Select the keys you push to hide or show Snagit on your desktop.  

Select a combination of boxes for <CTRL>, <SHIFT>, and/or <ALT>, and a keyboard 
character. 

Repeat Last 
Capture hotkey 

Select the keys you push to have Snagit capture the last area again.  

Select a combination of boxes for <CTRL>, <SHIFT>, and/or <ALT>, and a keyboard 
character. 

Default Click Default to restore the options back to their original settings.  

Snagit Program Options Tab 

 Snagit > Tools menu > Program Preferences > Program Preferences tab. 

Select general program options.  

Option Description  

Run Snagit when Windows 
starts 

Snagit will load each time Windows is started. Default setting. 

Hide Snagit before capturing Snagit will close temporarily before capturing and reopen after the capture is 
done. Default setting. 

Show magnifier window Snagit displays a zoom magnifier window when performing capture that requires 
selecting a region. Default setting. 

Show help text window Snagit displays a help window during capture that gives additional instructions 
about completing that capture. Default setting. 

Use tray icon Snagit places a small Snagit icon in the System Tray. Double-click this icon to 
open Snagit. Default setting. 

Close to tray Snagit minimizes the Snagit application icon to the tray when closed. This option 
is only available if you have also selected Use tray icon. Default setting. 

Minimize to tray Snagit minimizes the Snagit application icon to the tray when closed. This option 
is only available if you have also selected Use tray icon. 

Foreground Editor Snagit forces the Snagit Editor into the foreground (with focus) after a capture. 
Default setting. 

When capturing images from DirectX programs, deselect this option. 

Paste Images as HTML for 
Outlook Express 

Snagit pastes images into Outlook Express using HTML. This allows the image 
to display correctly.  

Each time you copy or paste, this option leaves files on your computer. 

Embed images when sending 
e-mail (Outlook/Outlook 
Express only) 

Snagit inserts images directly into an e-mail message. If you would rather have 
images attached to e-mail as files, turn this option off. It is selected by default. 

Embedding images requires that the client is configured to use the HTML e-mail 
format and the Send Pictures with E-Mail option to be enabled. 

File Associations Open the File Associations dialog box to set up the types of file formats to open 
within Snagit Editor. The following options are available: 

File types to associate with Snagit Editor: Use to select individual file types, 
one at a time. 

Select All: Use to select all of the file types at once. 

Clear All: Use to select all of the file types at once. 

Reset Configuration Returns all settings for the current profile to the program defaults. All other 
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profiles remain unaffected by this change. 

Clear History Clear all of the entries from the recent lists or dropdown menus within Snagit.  

Snagit Notifications Tab 

 Snagit > Tools menu > Program Preferences > Notifications tab. 

Snagit notifies of problems and errors. 

 When using timer-activated capture, disable all popup messages and select the Log Events to a File option. This 
allows Snagit to operate unattended, since communications errors can occur for a number of reasons. Snagit logs the 
errors, and continues running. 

Option Description  

Popup messages Snagit will notify on errors and/or Show warnings when it encounters errors.  

Select Show all tips to enable general Snagit program tips. Deselect it to disable the 
tips. 

Select Show all balloon tips to enable Snagit balloon tips. Deselect it to disable the 
tips. 

These are the default settings 

Log events to a file Log events to a designated file. Also, use the radio buttons to select the type of event 
to write: Errors only or Information and errors. 

Log file Type the name of the log file or use the Browse button to locate the desired log file.  

Max lines Indicate the maximum number of lines to save. 

Audible alert  Select the Hotkey is pressed option to set Snagit to make a sound when a hotkey is 
pressed. 

Select the Capture is finished option to set Snagit to make a sound when a capture is 
finished. 

Snagit Update Options Tab 

 Snagit > Tools menu > Program Preferences > Update Options tab. 

Set Snagit to automatically check for program updates.  

 When using timer-activated capture, disable all popup messages and select the Log Events to a File option. This 
allows Snagit to operate unattended, since communications errors can occur for a number of reasons. Snagit logs the 
errors, and continues running. 

Option Description  

Enabled automated 
update checking 

Snagit automatically checks for program updates on the Snagit Web site. 

Default setting.  

Days between checks Select the number of days between checking for updates. The default entry is 14 days.  

Prompt before update 
check 

Snagit will prompt for Internet access information before checking for an update. 
Typically, if you are on a dial-up connection, you need to sign on to your Internet 
provider in order to access the Web. 
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Tutorials 
We’ve included a few tutorials in this help file. There are many more, written and video, located at the 
TechSmith.com Learning Center on our web site. 

Available in this help file are the following tutorials: 

 What You Need to Know About Transparency 

 Basic Snagit Tips & Tricks 

 How to Use Hotspots 

 Introduction to Searching and Tagging 

 Sharing Captures from Snagit  

What You Need to Know About Transparency 
 

What is Transparency? 

Simply put, transparency is the ability to see through part or all of an image.   

 

To understand how transparency in image files works, it’s helpful to understand the terms opaque, 
translucent, and transparent. 

 

Opaque means completely solid. You can’t see through something that is opaque. In the real world, 
this might be a wall or a door.  

http://www.techsmith.com/learn/snagit/
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Translucent means partially opaque and partially transparent. It’s an in-between state. In the real 
world, this is like a stained glass window. You can see through it, but not in the way you see through 
clear glass. This state is referred to as partially transparent in image files. 

Transparent means completely clear or see-through. Something that is transparent might as well be 
invisible. In the real world this is a clear glass window, or even the air that is all around us. 

Why Should You Care About Transparency?  

That’s an easy question. It’s going to make your images look great. When layered on top of other 
images, whether it’s a web page with colored backgrounds or presentation slide templates, a 
transparent image is going to look professional and polished. 

The screenshot on the left below has no transparency; the screenshot on the right has a transparent 
canvas and a partially transparent shadow. 

 

Because image files are always rectangular, complete or partial transparency is the solution used to 
create the appearance of irregular edges or see-through portions. 

 

Transparency in Snagit 

In Snagit Editor (and most other graphics programs) transparency is represented by a white and gray 
checkerboard pattern. This pattern shows you what parts of the image you can see through. 

 

When using the window selector of the All-in-One input or the Window input, Snagit captures the 
rounded corners of windows and the transparency of Aero themed title bars. It can also capture oddly 
shaped windows without grabbing the desktop or windows behind. 
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Snagit Editor can introduce transparency during editing with drawing tools and image effects. Edge 
effects like borders and drop shadows no longer add a background color to your image. Instead, they 
look great anywhere you put them. 

Saving a Transparent Image 

Snagit supports complete and partial transparency in capturing and editing. However, to have 
complete or partial transparency in your final saved image, you must use a file format that supports 
your desired level of transparency.  

Complete and partial transparency is best supported by PNG and the SNAG file formats. 

Common File Formats Supports Transparency? 

PNG Yes 

JPG No 

BMP No 

GIF Single color, full transparency 
only 

TIF Yes 

SNAG Yes 

 

 What if I use a format that doesn’t support transparency? The preview pane in the Save dialog 
box shows you how the saved image looks in your selected format. 

For more information on using transparency in Snagit, see Transparency. 

Additional tutorials: 

 Basic Snagit Tips & Tricks 

 How to Use Hotspots 

 Introduction to Searching and Tagging 

 Sharing Captures from Snagit 

Basic Snagit Tips & Tricks 
Here are some tips and tricks that can help you get the most out of Snagit.  

Whether assembling common captures into profiles or just changing the color scheme of the Snagit 
user interface, these tips can save you time and help you make great looking images. 

Change the Color of the User Interface 

Don’t like Snagit’s default black color scheme? Not a problem. Silver and blue themes for both Snagit 
and Snagit Editor are available. 
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In Snagit:  

 Tools > Program Preferences > Program Options tab > Color scheme dropdown 

In Snagit Editor:  

 Snagit button > Editor Options > General tab > Display options > Color scheme dropdown 

 

Create Profiles for Common Tasks 

Find yourself changing the same settings over and over? Create profiles that match your most 
frequently used configurations. 

For more on profiles, see Snagit Profiles. 

Skip the Editor, Go Straight to an Output 

Don’t need to edit your screenshot, or perhaps you want to send your screenshot straight to the 
Clipboard? Change your capture output options to skip the Editor. 

First, select an output from the Output dropdown menu in the Profile Settings pane. This could be the 
Clipboard, an output to a particular program, or even straight to a file. 

To skip previewing your capture in the Editor, deselect the Preview in Editor option in the same 
menu. 
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 If you want quick access to these settings, considering saving them as a profile. 

Preview Transparency in the Tray 

Curious how the transparent parts of your image look without the checkerboard pattern that indicates 
transparency in the Editor? Check out your Open Captures Tray. 
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The thumbnail previews in the Open Captures Tray show your transparent images on a black 
background and top of the dark gray background or the orange selection color of the Tray itself. This 
isn’t always a preview of how your image looks on your intended background, but it gives you an idea 
of how it might look against a dark background. 

Ctrl + Selection to Clone Areas 

Holding <CTRL> while moving a selection created with the selection tool doesn’t move the selection, 
but instead makes a copy. This copy flattens after you’ve moved it, just like a normal selection.  

Use this technique to quickly “clone” an area to fill in gradients, create copies of buttons or text fields, 
or anything else you might want to quickly copy and place.  

Use the SNAG File Format to Archive Projects 

To save vector object information (all those callouts, pasted images, and the other stuff that makes 
the Editor neat), use the SNAG file format. When you take a capture, this is the format that Snagit 
uses to auto-store your image until you save it to your preferred file format.  

If you want to edit your image again later, save a copy as a SNAG file. These files aren’t viewable 
outside of Snagit, but they save all the information about your capture so you can move all the 
elements. 
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A Few Basic Design Tips 

Screenshots benefit from the same ideas and techniques that a graphic designer might use when 
creating content. Here are a few to think about when creating images.  

 Rule of thirds: The human eye finds some images more interesting than others. Dividing an 
image into thirds shows you where the most interesting parts of your image should be. Divide 
your image into thirds both horizontally and vertically, creating nine boxes. Try placing things like 
callouts, arrows, and text along those lines for maximum impact. 

 

 Color selection: Use complimentary colors (colors located opposite on a color wheel) in your 
effects to create a look of cohesion in your image.  

 

 Think about context: What do you want your audience to look at? Is it important that they see 
your screenshot in the larger context of what was on your screen, or is it better to trim all that 
away and just show the exact window or button that you want to call attention to? Deciding may 
help your image communicate your message better. 

Additional tutorials: 

 What You Need to Know About Transparency 

 Basic Snagit Tips & Tricks 

 Introduction to Searching and Tagging 

 Sharing Captures from Snagit 

How to Use Hotspots 
 

A hotspot is a region of an image that contains special interactive elements, such as hyperlinks or 
popup tooltips. You can add hotspots to your images in Snagit that can highlight, hyperlink, or popup 
useful information when the mouse cursor passes over.  

Hotspots can also be used to capture hyperlinks on web pages by enabling the Keep Web Links 
Active option in the Profile Settings pane.  
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 You can only see and edit hotspots on the Hotspots tab.  

 Hotspots only work when you save your capture in a format that supports them, most commonly 
SWF. They can be viewed in most web browsers and HTML-enabled email programs. 

Why Use Snagit Hotspots? 

Use them to create: 

 Links: Select a region of your image and turn it in to a hyperlink with an optional tooltip. Link to a 
website, or another image using a file path. 

 Highlights: Select a color and opacity level for a highlight that appears when the mouse cursor 
passes over. 

 Image or text popups: Select another image file or enter a text to appear when the hotspot is 
moused-over. 

 You cannot edit SWF files in the Snagit Editor. Before saving your capture with hotspots in a 
format that supports them, consider saving it as a SNAG file first, so the hotspots can be edited 
later. 

Additional tutorials: 

 What You Need to Know About Transparency 

 Basic Snagit Tips & Tricks 

 Introduction to Searching and Tagging 

 Sharing Captures from Snagit 

Introduction to Searching and Tagging 
 

Snagit Editor includes a Library of all your previous captures. This could get overwhelming, but 
thanks to the powerful search and tagging capabilities of the Library, you can easily find the capture 
you’re looking for. 

Search Pane  

The Search Pane is the way to browse or search your Library. The captures displayed in the main 
Library window are filtered by your search results or the selected options in the Tags, Dates, or 
Folders tabs. 
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 Search box 
Use the search box to search file names, keywords, and any metadata that is taken with the 
capture. Metadata includes the program it was captured from, the web site address, and even the 
web site title. This is great if you know exactly what you want, or are looking across all your 
captures. 
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 Tags 
Browse your Library by a particular tag. 
Snagit creates tags automatically based on 
metadata. 

 Recent captures: 
View captures based on date. View 
captures from the past month, or view 
weekly breakdowns. 

 Applications: 
View captures by the application they 
were captured from. 

 Web sites: 
View captures based on the top level 
domain (e.g. www.techsmith.com). 

 Keywords: 
View captures based on keywords 
entered on the Tags tab of the Editor. 
For more information on keywords, see 
the Tags Tab. 

 Flags: 
View captures by the user-assigned 
flags (assigned from either the Tags 
tab or the bottom of the search pane). 
 

 

 Dates 
Browse your captures by year, months, or even specific day. 
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 Folders 
Browse your file system for image files. This view functions in a similar way to the Windows File 
Explorer. 

 

Flags and Keywords 

Flags function as visual markers; add them to a capture to make it stick out in your Tray or in the 
Library view. Each flag shows as a small badge on top of image thumbnails. Snagit provides names 
for the various flags, but these are just suggestions. The multicolored flags can symbolize whatever 
you like; the important thing is that they stick out visually. 

 

Keywords are a bit more specific. They’re all user defined. Think of keywords as a way to add 
information to your captures that shows up in searches and the Tags panel of the search pane. Try 
labeling captures with the name of project or the contents of the screen. 

The important thing to remember about flags and keywords is that they help you find and view groups 
of related captures. If you need to organize your captures, think flags and keywords. 

 You must manage media files with keywords and flags assigned within Editor or you lose the 
keywords and flags.  
 
For example, to move files with keywords and/or flags from one folder to another, you must use 
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the Folder tab within the Search Pane. If you use Windows Explorer or another method to move 
these files, all keywords and flags are permanently lost.  

Additional tutorials: 

 What You Need to Know About Transparency 

 Basic Snagit Tips & Tricks 

 How to Use Hotspots 

 Sharing Captures from Snagit 

Sharing Captures from Snagit 
 

You’ve taken your capture and made your edits. What’s next?  

Snagit has a few handy tricks to help you and your capture get where ever it is you’re going. 

Copy All 

Use the Copy All button to copy a flattened version of your image to the Clipboard. Paste it where 
ever you’d like to use your image. This is useful for pasting your capture in to an email, document, or 
other authoring tool. 

Outputs 

Snagit can automatically send your capture to various destinations. These destinations are called 
outputs.  

You can choose an output while setting up a capture in the Profile Settings pane. After editing your 
capture, click the Finish Profile button to send your capture to the selected output. 

You can also select an output from the Send tab (or the Send dropdown on the Draw tab) to send 
your capture to an output from the Editor. 

Outputs include: 

 E-mail 

 FTP 

 Program 

 Clipboard 

 Microsoft Office® Word, Excel, and PowerPoint 

 Screencast.com, TechSmith’s image and video hosting service 

Output Accessories 

The Microsoft Office and Screencast.com outputs are accessories; they operate just like the other 
outputs, but go to a specific program. Aside from the four that come installed with Snagit, you can 
download other output accessories from the TechSmith web site.  

Output accessories contain special options that are unique to their destinations. The blog outputs 
allow you to compose a blog post to go alongside your capture. The Screencast.com output returns 
the URL of your uploaded image along with HTML code that includes a thumbnail when you paste 
that URL in an HTML capable field. 
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You can find the accessories download page by opening Manage Accessories from the Snagit 
Related Tasks list. Click the Get More Accessories button on the bottom left to go to the Snagit 
Accessories web page. 

Additional tutorials: 

 What You Need to Know About Transparency 

 Basic Snagit Tips & Tricks 

 How to Use Hotspots 

 Introduction to Searching and Tagging 

http://www.techsmith.com/snagit/accessories.asp
http://www.techsmith.com/snagit/accessories.asp

